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1. What does the package contain? 
- Toolbox for pro 
- Help file 

2. What is geoprocessing? 
ArcGIS Pro  | Other versions| Help archive 
Geoprocessing is a framework and set of tools for processing geographic and related data. 
The comprehensive suite of geoprocessing tools can be used to perform spatial analysis 
or manage GIS data in an automated way. Geoprocessing is for everyone that uses 
ArcGIS Pro. Whether you are a new or advanced user, geoprocessing will likely be an 
essential part of your day-to-day work. 
 

      
Geoprocessing is used to automate GIS tasks and for modeling and analysis. 
 
A typical geoprocessing tool performs an operation on a dataset such as a feature class, 
raster, or table, and creates a resulting output dataset. For example, the Buffer tool takes 
features as input, creates buffer areas around the features to a specified distance, and 
writes those buffer areas to a new output dataset. 
Additional resources from ESRI that will help you. 
 
What is geoprocessing? 
 
Geoprocessing quick tour 
 
Customize ArcGIS Pro with geoprocessing tools 
 
What is ModelBuilder? 
 
ModelBuilder Add and connect data and tools and modify elements 
 
Create a model tool 
 
Use ModelBuilder 
 
Run a model in ModelBuilder 
 

https://pro.arcgis.com/en/pro-app/latest/get-started/archived-arcgis-pro-help.htm
https://pro.arcgis.com/en/pro-app/3.1/tool-reference/analysis/buffer.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/geoprocessing/basics/what-is-geoprocessing-.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/geoprocessing/basics/geoprocessing-quick-tour.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/geoprocessing/basics/customize-arcgis-pro-with-geoprocessing-tools.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/geoprocessing/modelbuilder/what-is-modelbuilder-.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/geoprocessing/modelbuilder/add-connect-and-modify-data-and-tools-in-a-model.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/geoprocessing/modelbuilder/create-a-model-tool.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/geoprocessing/modelbuilder/modelbuilder-quick-tour.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/geoprocessing/modelbuilder/run-a-model.htm
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3. How to use? 
• Add to project: To use the tool, you first need to add it to your ArcGIS Pro project. 

Using the attachment sent to the email, unzip the toolbox and then add to your 
project. 

 

Add an existing toolbox to a project 

You can add an existing toolbox to the catalog's Toolboxes container . This allows you to 
access the toolbox without browsing to a folder or database. 

•  Open the Add Toolbox browse dialog box by using any of the following methods: 

On the ribbon 
Click the Insert tab. In the Project group, click Toolbox  

and click Add Toolbox . 

In the 
Conte
nts 
pane 
of a 
catalo
g view 

Click Toolboxes . On the ribbon, click the Catalog tab. In 

the Create group, click Add  and click Add 

Toolbox . 

In the 
Catalo
g 
pane 

On the Project tab, right-click Toolboxes  and click Add 

Toolbox . 

•  
•  Browse to and select one or more toolboxes on your local computer, on a network 

computer, or in a file geodatabase. 
•  Click OK. 

The toolbox appears in the Toolboxes container  in the Catalog pane and the 
Contents pane of a catalog view. 
You can also add a toolbox to a project using the following methods: 
 

In the Catalog 
pane, a 
catalog 
view, or 
the 
Content
s pane of 
a catalog 
view 

◦ Browse to a toolbox, right-click it, and click Add To 

Project . 

◦ Browse to a toolbox, select it, and drag it to the 

Toolboxes container  in the Catalog pane or the 
Contents pane of a catalog view. 
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In File Explorer 

Browse to a toolbox, select it, and drag it to the Catalog 
pane or the Contents pane of a catalog view. It 

appears in the Toolboxes container . 

•  
 

• Open ArcGIS Pro in a new or existing project: You can either start a new 
project or open an existing one, depending on your specific needs. 

• Open the catalog: In ArcGIS Pro, the Catalog pane is where you manage your 
data, tools, and 

projects. 
 
 
 
 
 
 
 
 
 
 
 

• Select right mouse button: Right-click on the toolbox to access its functions. 

• From the menu, point to add toolbox: In the context menu, you can choose to 
add the toolbox to your project. 

 

• You navigate to the once archived tool: Once you've added the toolbox, you can 
locate the specific tool you want to use. 
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• Add to project: If you want to make it easier to access frequently used tools, you 

can copy the contents of the toolbox to your own toolbox within the project. 
• Configure Parameters for Sending Test Email: 

                   
• Right-click to select "Test Sending Emails" and go to Properties. 
• Choose Parameters. To receive emails, fill in the login_email with the email 

address used during the subscription. This email address will be validated for 
sending emails. 
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• Without a valid email, an error will occur in the GP message. 

 
 

• To view details, select "View Detail." 
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•  With a valid email, the message will confirm to check your mailbox for the sent 

email. 
 

 
 

• You should check your mailbox for the sent email 
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4. How is it used in a model? 

On the ModelBuilder tab, click Insert > Tools , and add geoprocessing tools and 
model-specificBy selecting the toolbox through the catalog in Pro: Open ArcGIS 
Pro and navigate to the Catalog pane. Here, you can browse your file system or 
network for the toolbox and add it to your project. Select the script: From the toolbox 

in your project, locate the script 
or tool you want to use in your 
model. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Copy it to the model you want to send emails to: Drag and drop the script into 
your model workspace. 
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• Connect it to the last operation in the model by dragging the arrow: To define 
the sequence of operations in your model, connect the email script to the previous 

tools or processes in your model. You do this by connecting the arrows or lines 
between them. 

 

• Select gp_management 
 

• Validate: After creating your model, validate it to ensure there are no errors or 
issues. 

• Save: Don't forget to save your model in your project. 

 

4. How are parameters configured? 
• Check the parameters with the properties selection of the script: To configure 

the script's parameters, access its properties. Here, you can specify things like 
input and output paths, email addresses, and other settings. 

• By default, the model is associated with the email address specified in its 
subscription: The script may have default settings for certain parameters, 
including the email address. You can use these defaults or change them as 
needed. 
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• You can include additional parameters from model properties: Depending on 
the script and your model's requirements, you may be able to add or modify 
parameters. 

 
 
 
 
 
 
 
 
 

•  

• Select Double click to add custom text messages 

• Write text messages 
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• The email parameter is mandatory for the job: If sending emails is a key 
function of the tool, the email parameter is crucial, and you must provide a 
valid email address. 

 
 

5. How to test geoprocessing? 
• Complete the steps of "How to use in a model" and configure the 

parameters: Set up your model 
by following the steps mentioned 

earlier. 
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• Save the pattern: Save your model configuration so that you can easily 
reuse it. 

 
 
 
 
 
 
 
 
 
 
 
 

• Just run it: Execute the model, and it will perform the geoprocessing tasks. 
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• Geoprocessing is finish: 
 

• You should receive a notification email: If your geoprocessing model 
involves sending emails, you should receive a notification email as 
configured. This confirms that the tool executed successfully. 

 
 

Configuration in a Workflow 
• Repeat email address settings for the other two geoprocessing steps. 

• About SendEmailBasic: 
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•  Select Properties and, in the Parameters section, change the email 
address to a valid one. 

 
•    About myScript: 

 
• Select Properties, change the email address, and set the path to the 

active toolbox. 

 
• You also need to make one additional setting to use the myScript tool: 

indicate the path to the active toolbox. This refers to the toolbox 
loaded into the project. This step is necessary to auto-populate the 
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path in the future. Select the folder on the right and set the path to the 
toolbox. 

 
• You can use multiple toolbox copies, specifying the path for each Pro 

project. 
 
Using the Email Notification Tool in Practice: 

• Embed your geoprocessing in "myModel" to get status notifications. 

• Select "Edit" on myModel. 

•  
• Now, build your new geoprocessing, or if you already have one built, 

copy it into ProEmail.atbx. Then, pass it inside myModel. For example, 
suppose you want to embed an already implemented model to track its 
execution and receive an email with the execution status. Please note 
that 'Upload files'—selected to illustrate the example—is not contained 
in this package 
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• Build or copy your geoprocessing into ProEmail.atbx and pass it inside 

myModel. 
 

 
Paste the sample model 
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• The model has been transferred. 

 
 

• Now, we're going to embed it in myModel. If there is previous content 
in myModel, highlight it and select 'Cut.' Now, copy 'Upload files' or 
drag and drop it into the myModel window. 
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• If necessary, update the model parameters. 

• Validate and save myModel (do not execute it). 

 
 

• Important do not execute myModel !!! 
 

 
Running the model myScript 

• MyScript is always executed; this is because all the validation, 
message interception, and email notification logic are in myScript. 
Model myModel is a container in which your geoprocessing models or 
tools are embedded. Let's run myScript and review the output. With a 
double wedge, we open myScript; there is no need to change the 
parameters as we have already set them in the previous steps. If there 
is still a mismatch in the parameters, please check the previous steps. 
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• Verify the email address for comprehensive execution details. 

 

• Important: The unusable emails from the image user@gisgp.com, it is 
for illustration only. 

 
 

 

• Open myScript and RUN it.  

• Check View Details for geoprocessing details. 
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Sample Messages 

 
• Let's check the email address. The email contains all the details 

regarding the execution of the model. 

 
• If you want to use new geoprocessing, you can create a new project 

with a copy of the toolbox. Be sure to redirect the path in the tools to 
the new location of ProEmail.atbx. 
 
 

How to handling Errors in geoprocessing 
• Receive notifications for geoprocessing errors. 

• Run myScript with a model containing an error. 

• Check the email for error details. 
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• The bug is contained in the built-in geoprocessing; let's take a look.  
 

 
 

• We also observe the described parameters, start time and date, and the 
error that occurred in the email.  
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• This way, you can be notified promptly in case of non-working 
geoprocessing and make the necessary corrections immediately. 
 
Successful Geoprocessing: 

• Create a new project with a copy of the toolbox for new geoprocessing. 
 

For Questions 

•    Visit the website, see the FAQ section www.gisgp.com  

•     Fill out the form on the site or use support@gisgp.com  
 

 

http://www.gisgp.com/
mailto:support@gisgp.com

